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View	Discussion	Improve	Article	Save	Article	Like	Article	Have	you	ever	encountered	an	error	in	your	Android	Studio	when	you	try	to	run	an	application	on	your	Emulator	which	shows	that	your	ADB	binary	found	in	your	system	is	obsolete	and	has	some	serious	performance	issues?	If	yes,	then	by	reading	this	article	your	problem	would	be	solved	and
you	will	be	able	to	run	your	app	easily	without	any	problems.	Below	is	the	screenshot	of	the	error	which	is	shown:	Methods	to	Solve	the	ProblemThere	are	some	methods	to	solve	this	problem.	Just	try	a	method	if	that	doesn’t	work	skip	to	the	next	method.	Let’s	see	what	are	those	methods:Method	1.	By	installing	the	latest	SDK	Build	ToolsIn	this
method,	we	would	delete	the	previously	installed	SDK	Build	Tools	and	install	the	latest	SDK	build	tools.	It	would	most	probably	solve	your	problem.		So	we	would	begin	the	method	by	first	opening	SDK	Manager.	You	can	find	it	in	the	tools	which	are	present	on	the	top	menu	bar.After	opening	the	SDK	Manager,	navigate	to	Appearance	&
Behavior/System	Settings/Android	SDK.	Then	go	to	SDK	Tools	Tab	and	check	the	Show	Package	Details	which	is	present	below.	Now	uncheck	the	earlier	installed	versions	and	then	click	on	the	latest	version	which	is	available.	In	my	case,	the	latest	version	available	is	30.0.3.	It	will	look	something	like	this:Click	on	Apply	Button	to	apply	the	settings
that	we	changed.	A	new	prompt	will	open	and	will	ask	you	to	confirm	the	change,	click	on	OK	Button.	After	clicking	on	OK	Button	the	installation	will	start.	When	the	installation	of	the	components	is	done,	click	on	Finish	Button.Now,	click	on	Ok	Button	and	your	problem	is	solved.Method	2.	Enable	the	Use	detected	ADB	Location	It	can	happen	that
the	Use	detected	ADB	location	is	not	enabled	in	your	Emulator	Settings.	So,	in	this	method,	we	learn	how	to	enable	it	to	solve	our	problems.	Click	on	the	three	dots	present	at	the	right	side	of	the	emulator	where	the	options	are	showed.	Now	go	to	Settings	and	enable	the	Use	detected	ADB	location	present	in	the	General	Tab.I	hope	that	after	applying
these	methods,	you	were	able	to	solve	the	problem.	Home	›	Androidプログラミング入門	›	Android	SDKのインストール	広告	Android	Studioの更新状況を確認し、Android	StudioをアップデートしたりAndroid	SKDをアップデートする方法について解説します。	目次	Android	Studioをアップデートする	Android	SDKをアップデートする	Android	Studioをアップデートする
Android	Studioを起動してください。	画面下にある「Configure」をクリックし、表示されたメニューの中から「Check	for	Updates」をクリックしてください。	今回は新しいバージョンのAndroid	Studioが見つかり「A	new	Android	Studio	3.2.1	is	available	in	the	stable	channel.」と表示されました。	最新版にアップデートする場合は、右下に並んでいる4つのボタンの中から
「Update	adn	Restart」をクリックしてください。	必要なファイルのダウンロードが開始され、Android	Studioのアップデートが行われます。	更新が完了すると、以前のバージョンのAndroid	Studioに関する設定をインポートするかどうかの確認画面が表示されます。今回は「Previous	version」を選択しインポートすることにしました。選択が終わりましたら「OK」をクリックしてくださ
い。	Android	Studioの最新版への更新が完了しました。	再度「Check	for	Updates」をクリックするとAndroid	SDKのアップデートが見つかり「Updates	are	available	for	the	Android	SDK	and	Tools」と表示されました。	アップデートする場合は、「Update	Now」をクリックしてください。	Android	SDKのライセンスに関する画面が表示されます。今回の場合は2つのライセンスに同
意する必要があります(アップデートによって異なると思います)。	最初に「android-sdk-license」をクリックします。すると「Android	Software	Development	Kit」に関するライセンスが画面に表示されます。	よく読んでいただき、同意できる場合には画面下部の「Accept」を選択してください。	次に「intel-android-extra-license」をクリックします。すると「Intel	(R)	Hardware
Accelerated	Execution	Manager	End-User」に関するライセンスが画面に表示されます。	よく読んでいただき、同意できる場合には画面下部の「Accept」を選択してください。	2つのライセンスに同意したあと「Next」をクリックしてください。	必要なファイルのダウンロードが開始され、Android	SDKのアップデートが行われます。	最後に次の画面が表示されました。「Finish」をク
リックして画面を閉じてください。	Android	SDKのアップデートが完了しました。	--	--	Android	StudioやAndroid	SDKを最新版にアップデートする手順について解説しました。	(	Written	by	Tatsuo	Ikura	)	Twitterでシェアする	Profile	著者	/	TATSUO	IKURA	初心者～中級者の方を対象としたプログラミング方法や開発環境の構築の解説を行うサイトの運営を行っています。	#発生してい
る問題・エラーメッセージ	Android	studioのエミュレータを起動したら、以下のエラーメッセージが表示されました。	これについて、AndroidStudio「The	ADB	binary	found	at～adb.exe	is	obsolete」の解決法や、というサイトを見つけたので、それの通りにやっていました。	Android	Studio	をインストールした後は、自動更新と	Android	SDK	Manager	により、簡単に	Android
Studio	IDE	と	Android	SDK	Tools	を最新に保つことができます。	IDE	の更新とチャンネルの変更	IDE	のアップデートが利用可能になると、Android	Studio	は小さなバブル	ダイアログで通知します。また、[Help]	>	[Check	for	Update]（Mac	では	[Android	Studio]	>	[Check	for	Updates]）をクリックして、アップデートを手動で確認することもできます。	Android	Studio	のアップ
デートは、次のリリース	チャンネルから入手できます。	Canary	チャンネル:	テスト中の最新リリースで、ほぼ毎週更新されます。developer.android.com/studio/preview	でダウンロードできます。	Android	Studio	の	Canary	版に加え、その他の	SDK	Tools（Android	Emulator	など）のプレビュー版を受け取ることもできます。	このチャンネルのビルドには多くのバグが含まれている可
能性がありますが、テストは実施されています。Google	がこれらのビルドを提供しているのは、デベロッパーが新機能を試してフィードバックを提供できるようにするためです。このチャンネルは、本番用の開発には推奨されません。	Dev	チャンネル:	社内テストにすべて合格して選ばれた	Canary	ビルドです。	Beta	チャンネル:	安定した	Canary	ビルドをベースにしたリリース候補で、
Stable	チャンネルで公開する前にフィードバックを受ける目的でリリースされます。	Stable	チャンネル:	developer.android.com/studio	でダウンロードできる公式の安定版リリースです。	本番環境用の	Android	プロジェクトには	Stable	ビルドを使用する一方で、いずれかのプレビュー	チャンネル（Canary、Dev、Beta）も試したい場合は、両方をサイド	バイ	サイド	インストールできま
す。	既存のインストールのアップデート	チャンネルを変更する手順は次のとおりです。	[File]	>	[Settings]（Mac	の場合は	[Android	Studio]	>	[Preferences]）をクリックして、[Preferences]	ウィンドウを開きます。	左側のパネルで、[Appearance	&	Behavior]	>	[System	Settings]	>	[Updates]	をクリックします。	[Automatically	check	for	updates]	がオンになっていることを確
認し、プルダウン	リストからチャンネルを選択します（図	1	を参照）。	[Apply]	または	[OK]	をクリックします。	図	1.	Android	Studio	のアップデートの設定	未使用の	Android	Studio	ディレクトリの削除	Android	Studio	のメジャー	バージョンを初めて実行する際、Android	Studio	は、対応するインストールが見つからない	Android	Studio	バージョンのキャッシュ、設定、インデック
ス、ログを格納しているディレクトリがないか探します。未使用ディレクトリが見つかった場合、その場所やサイズ、最終更新日時が	[Delete	Unused	Android	Studio	Directories]	ダイアログに表示され、削除オプションが表示されます。	Android	Studio	が削除対象と見なすディレクトリは以下のとおりです。	Linux:	~/.AndroidStudio[Preview]_version_	Mac:
~/Library/{Preferences,	Caches,	Logs,	Application	Support}/AndroidStudio[Preview]_version_	Windows:	%USER%\.AndroidStudio[Preview]_version_	SDK	Manager	でのツールの更新	Android	SDK	Manager	では、アプリの開発に必要な	SDK	ツール、プラットフォーム、その他のコンポーネントをダウンロードできます。ダウンロードされた各パッケージは、図	2	の
[Android	SDK	Location]	で示されているディレクトリに格納されます。	Android	Studio	から	SDK	Manager	を起動するには、[Tools]	>	[SDK	Manager]	をクリックするか、ツールバーで	SDK	Manager	アイコン	をクリックします。Android	Studio	を使用していない場合は、sdkmanager	コマンドライン	ツールを使用してツールをダウンロードできます。	すでに所有しているパッケー
ジのアップデートが使用可能になると、パッケージの横のチェックボックスにダッシュ	が表示されます。	アイテムを更新する、または新しいアイテムをインストールするには、チェックボックスをクリックしてオンにします。	パッケージをアンインストールするには、チェックボックスをクリックしてオフにします。	保留中のアップデートは、左の列に表示されるダウンロード	アイコン	によって
示されます。保留中の削除は、赤い印	によって示されます。	選択したパッケージを更新するには、[Apply]	または	[OK]	をクリックして、使用許諾に同意します。	図	2.	Android	SDK	Manager	推奨パッケージ	[SDK	Tools]	タブで特に注目すべきツールをご紹介します。	Android	SDK	Build-Tools	必須。Android	アプリをビルドするために必要なツールが含まれています。SDK	Build	Tools
のリリースノートをご覧ください。	Android	SDK	Platform-Tools	必須。adb	ツールなど、Android	プラットフォームに必要な各種ツールが含まれています。	Android	SDK	Tools	必須。ProGuard	などの基本的なツールが含まれています。SDK	Tools	のリリースノートをご覧ください。	Android	Emulator	推奨。実際の	Android	ランタイム環境でのアプリのデバッグとテストに使用でき
る、QEMU	ベースのデバイス	エミュレーション	ツールです。Android	Emulator	のリリースノートをご覧ください。	注:	これまで	Support	Repository	パッケージで提供されていたほとんどの	API	ライブラリ（Android	サポート	ライブラリ、Constraint	Layout、Google	Play	開発者サービス、Firebase	など）は、現在は	Google	の	Maven	リポジトリで提供されています。Android
Studio	3.0	以降で作成されたプロジェクトでは、このリポジトリがビルド設定に自動的に含まれます。それより前のプロジェクトを使用している場合は、Google	の	Maven	リポジトリを	build.gradle	ファイルに手動で追加する必要があります。	[SDK	Platforms]	タブでは、Android	プラットフォームのバージョンも	1	つ以上インストールする必要があります。バージョンごとに複数のパッ
ケージが用意されています。必要なバージョンのみをダウンロードするには、バージョン名の横のチェックボックスをオンにします。	各	Android	プラットフォームで利用可能なパッケージをすべて表示するには、ウィンドウの下部にある	[Show	Package	Details]	をクリックします。プラットフォームの各バージョンには以下のパッケージが含まれています。	Android	SDK	Platform	必須。ア
プリをコンパイルできるようにするには、環境内に少なくとも	1	つのプラットフォームが必要です。最新のデバイスで優れたユーザー	エクスペリエンスを提供するために、アプリのビルド対象として最新バージョンのプラットフォームを使用してください。以前のバージョンでもアプリを実行することはできますが、最新バージョンの	Android	を搭載したデバイスで最新の機能を使用するには、ビ
ルド対象を最新バージョンにする必要があります。	Intel	または	ARM	システム	イメージ	推奨。Android	Emulator	を実行するには、システム	イメージが必要です。プラットフォームのバージョンごとに、サポート対象のシステム	イメージが含まれています。システム	イメージは、後で	Android	Virtual	Device（AVD）を	AVD	Manager	で作成する際にダウンロードすることもできます。開
発用コンピュータのプロセッサに基づき、Intel	または	ARM	を選択します。	注:	Google	Play	開発者サービス（Firebase	を含む）の	API	を使用する予定の場合は、Google	API	システム	イメージまたは	Google	Play	システム	イメージを使用する必要があります（後者には	Play	ストア	アプリが含まれています）。	このリストはすべてを網羅しているわけではありません。その他のサイトを追
加することで、サードパーティのパッケージをダウンロードすることもできます。	場合によっては、SDK	パッケージで別のツールの最小限の変更が必要になることもあります。その場合、SDK	Manager	で警告によって通知され、ダウンロードの一覧に依存関係が追加されます。	ヒント:	build.gradle	ファイルをカスタマイズして、各プロジェクトで特定のビルドチェーンとコンパイル	オプショ
ンを使用することもできます。詳しくは、Gradle	ビルドの設定の説明をご覧ください。	SDK	ツールサイトの編集または追加	Android	Studio	が	Android	のツールやサードパーティ製ツールの更新を確認する	SDK	サイトを管理するには、[SDK	Update	Sites]	タブをクリックします。独自のツールをホストするサイトを追加して、そのサイトからパッケージをダウンロードできます。	たとえ
ば、携帯通信会社やデバイス	メーカーが、自社の	Android	デバイスでサポートされる追加の	API	ライブラリを提供することもあります。そのようなライブラリを使って開発する場合、[SDK	Update	Sites]	で	SDK	ツールの	URL	を	SDK	Manager	に追加することで、Android	SDK	パッケージをインストールできるようになります。	携帯通信会社やデバイス	メーカーが自社のウェブサイトに
SDK	アドオン	リポジトリ	ファイルをホストしている場合は、次の手順でそのサイトを	Android	SDK	Manager	に追加します。	[SDK	Update	Sites]	タブをクリックします。	ウィンドウ下部にある	Add	アイコン	をクリックします。	サードパーティのサイトの名前と	URL	を入力し、[OK]	をクリックします。	[Enabled]	列のチェックボックスがオンになっていることを確認します。	[Apply]
または	[OK]	をクリックします。	これで、サイトで利用できるすべての	SDK	パッケージが	[SDK	Platforms]	または	[SDK	Tools]	タブに適宜表示されます。	不足しているパッケージの	Gradle	での自動ダウンロード	コマンドラインからビルドを実行する場合、または	Android	Studio	3.3	以降を使用している場合、対応する	SDK	ライセンス契約が	SDK	Manager	を通じてすでに承認されてい
さえすれば、プロジェクトに必要な不足している	SDK	パッケージを	Gradle	が自動的にダウンロードします。	SDK	Manager	を使用してライセンス契約を承認すると、Android	Studio	が	SDK	のホーム	ディレクトリ内にライセンス	ディレクトリを作成します。このライセンス	ディレクトリは、不足しているパッケージを	Gradle	が自動ダウンロードするために必要です。	注:	android	コマン
ドライン	ツールを使用してライセンス契約を承認した場合、このライセンス	ディレクトリは作成されません。この機能を使用できるようにするには、まず、SDK	Manager	を使用して契約を承認する必要があります。	ライセンス契約を承認したワークステーションとは別のワークステーションでプロジェクトを構築する場合は、承認済みのライセンス	ディレクトリ全体をコピーすることによって
ライセンスをエクスポートできます。ライセンスを別のマシンにコピーする手順は次のとおりです。	Android	Studio	がインストールされているマシンで、[Tools]	>	[Android]	>	[SDK	Manager]	をクリックします。ウィンドウ上部の	[Android	SDK	Location]	の設定をメモしておきます。	そのディレクトリに移動して、その中で	licenses/	ディレクトリを探します（licenses/	ディレクトリ
が見つからない場合は、Android	Studio	に戻って	SDK	Tools	を更新し、ライセンス契約を承認します。Android	SDK	のホーム	ディレクトリに戻ると、今度はディレクトリが表示されるはずです）。	licenses/	ディレクトリ全体をコピーして、プロジェクトを構築するマシン上の	Android	SDK	のホーム	ディレクトリに貼り付けます。	これで、プロジェクトに必要な不足しているパッケージを
Gradle	が自動ダウンロードできるようになります。	この機能は、Android	Studio	で実行したビルドでは自動的に無効化されます。これは、不足しているパッケージのダウンロードを	SDK	Manager	が	IDE	に代わって処理するためです。この機能は、プロジェクトの	gradle.properties	ファイルで	android.builder.sdkDownload=false	を設定することにより、手動で無効にすることもでき
ます。	

Para	os	registros,	tentei	remover	o	ADB.	Com:	sudo	apt-get	remove	android-tools-adb	android-tools-fastboot	Em	seguida,	reinstalei-o	com:	sudo	apt-get	install	android-tools-adb	android-tools-fastboot	Antes	deste	comando,	minha	versão	do	ADB	era	1.0.31,	ainda	é	1.0.31.	Turn	off	the	gadget	completely,	then	hold	the	volume	control	key	for	a	few
seconds.	Use	the	same	keys	to	select	“Apply	update	from	ADB”	and	click	on	“Power”.	Return	to	the	PC	and	in	the	command	prompt	window	type	“adb	sideload	firmware	file	name”.	After	Android,	it	opens	the	file	and	checks	it,	downloads	it	on	the	phone.	30/03/2022	·	Android	Debug	Bridge	(adb)	is	a	versatile	command-line	tool	that	lets	you
communicate	with	a	device.	The	adb	command	facilitates	a	variety	of	device	actions,	such	as	installing	and	debugging	apps,	and	it	provides	access	to	a	Unix	shell	that	you	can	use	to	run	a	variety	of	commands	on	a	device.	25/08/2020	·	On	a	machine	with	Android	Studio	installed,	click	Tools	>	Android	>	SDK	Manager.	At	the	top	of	the	window,	note
the	Android	SDK	Location.	Navigate	to	that	directory	and	locate	the	licenses/	directory	inside	it.	(If	you	do	not	see	a	…	06/06/2021	·	How	to	Update	Gradle	in	Android	Studio?	...	Fix	"Unable	to	locate	adb	within	SDK"	in	Android	Studio;	Android	Project	folder	Structure;	...	How	to	fix	“ADB.exe	is	obsolete	and	has	serious	performance	problems”	in
Android	Studio?	…	I	have	an	android	based	phone	and	I	need	ADB	for	installing	new	versions.	...	tools/android	update	sdk	--no-ui	Tip:	use	--help	to	see	the	various	command-line	options.	...	I've	downloadede	"All	Android	Studio	Packages"	but	there	is	no	Tools	folder	in	it.	11/05/2021	·	when	I	am	using	android	studio	and	running	the	emulator	it	works
but	gives	me	a	message	that	adb.exe	at	the	sdk	location	needs	to	be	updated	and	it	has	a	serious	performance	problems	I	tried	to	go	to	SDK	manager	and	tools	…	O	Android	Studio	usa	uma	pequena	caixa	de	diálogo	em	forma	de	balão	para	avisar	sobre	a	disponibilidade	de	atualizações	para	o	ambiente	de	desenvolvimento	integrado.	No	entanto,	você
pode	verificar	isso	manualmente	clicando	em	Help	>	Check	for	Update	(no	Mac,	Android	Studio	>	Check	for	Updates).	sqlite.	O	Android	Debug	Bridge	(adb)	é	uma	ferramenta	de	linha	de	comando	versátil	que	permite	a	comunicação	com	um	dispositivo.	O	comando	adb	facilita	uma	variedade	de	ações	do	dispositivo,	como	instalar	e	depurar	apps,	e	…
06/06/2022	·	Android	Debug	Bridge	(ADB)	lets	you	connect	your	development	workstation	directly	to	your	Android	device	so	you	can	install	packages	and	evaluate	your	changes.	To	learn	the	details	of	ADB,	review	its	README.	Confirming	you	have	ADB.	The	adb	tool	is	part	of	the	Android	Open	Source	Project	(AOSP).	ADB	is	available	after	you've
built	or	downloaded	ADB.
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